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1. OVERVIEW  

The 3080IPG-NAT platform is a complete hardware based solution to remove the need for service 
providers to enforce address range restrictions and VLAN schemes for their customers in multi-tenant 
environments. 
 
Controlled by the industry leading VistaLINK®PRO, the 3080IPG-NAT-2-10GE is a high density Network 
Address Translator (NAT) used specifically for video applications. It allows to bridge two IP networks by 
appropriately translating IP addresses of one network to another. When datagrams from one network 
enter into the inbound port of the NAT, its addresses in these datagrams get translated, and then delivered 
to a second network connected to the outbound port of the NAT. 
 
The 3080IPG-NAT provides the following three modes of operation: 
 

• The IP NAT which allows a static mapping between one unicast/multicast IP address from one 
network to another unicast/multicast IP address from another network. 

 
• The VLAN based NAT which allows a VLAN tagged datagram from one network to seamlessly 

enter into another network by encapsulating it as regular multicast. 
 

• The Port based NAT which allows applying a multicast IP address to all incoming datagrams on a 
physical port, and makes the datagrams appear as if they were a video stream when it enters into 
another network. 

 
The 3080IPG-NAT occupies two card slots and can be housed in, a 3RU frame which will hold up to 2 
modules, 6RU frame which will hold up to 7 modules, and 3700 frame which will hold up to 2 modules. 
 
 
Features: 
 

• IP NAT 
• VLAN base NAT  
• Port based NAT 
• Point-to-point and multi-point signal delivery over Ethernet 
• Operates over a IP/MPLS/VPLS core network 
• High Performance Studio Interconnects 
• In-band Management (Management Traffic transport over Multicast) 
• Fully controlled and monitored via VistaLINK® PRO 
• Flexible SFP Ethernet I/O for 4x1/10GE (SFP+) 
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Figure 1-1: 3080IPG-NAT-2-10GE Block Diagram 
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2. SPECIFICATIONS 

2.1. ONE-TO-ONE NAT 

• 2048xstatic mapping 
 

2.2. VLAN BASED NAT 

• 2048xVLAND ID mapping 
 

2.3. PORT BASED NAT 

• 2xdatagrams flow mapping (from 2x1/10GE) 
 

2.4. SFP MODULES 

• 4xSFP Modules 
• 4x10GbE Optical 1310nm (+SFPTR13-10G) 

 

2.5. PHYSICAL (NUMBER OF SLOTS) 

 3000FR:  2 
 3700FR:  2 

EMX3:  2 
EMX6:  7 

 

2.6. ORDERING INFORMATION 

 3080IPG-NAT-2-10GE:   High density NAT with 4xSFP 10GE 
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3. INSTALLATION 

3.1. REAR PLATE DESCRIPTION 

The 3080IPG-NAT comes standard with a companion +6RU rear plate. Figure 2-1 provides an illustration 
of the 3080IPG-NAT rear plate. 

 
Figure 2-1: Universal Rear Plate for 3080IPG-NAT-2-10GE 
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3.1.1. Ethernet Connection Control 
The 3080IPG-NAT Series uses 10Base-T (10 Mbps), 100Base-TX (100 Mbps) or Gigabit (1Gbps) twisted 
pair Ethernet cabling systems.  When connecting for 10Base-T systems, category 3, 4, or 5 UTP cable as 
well as EIA/TIA – 568 100Ω STP cable may be used.  When connecting for 100Base-TX systems, 
category 5 UTP cable is required.  The cable must be “straight-through” with an RJ-45 connector at each 
end.  Establish the network connection by plugging one end of the cable into the RJ-45 receptacle of the 
Frame Controller of the chassis and the other end into a port of the supporting hub. 
 
The straight-through RJ-45 cable can be purchased or can be constructed using the pin-out information in 
Table 2-1.  A colour coded wiring table is provided in Table 2-1 for the current RJ-45 standards (AT&T 
258A or EIA/TIA 258B colour coding shown). Also refer to the notes following the table for additional 
wiring guide information.  
 

Pin  
1 

 

Pin # Signal EIA/TIA 568A AT&T 258A or 
EIA/TIA 568B 

10BaseT 
or 100BaseT 

1 Transmit + White/Green White/Orange X 
2 Transmit – Green/White or White Orange/White or Orange X 
3 Receive + White/Orange White/Green X 
4 N/A Blue/White or Blue Blue/White or Blue Not used (required) 
5 N/A White/Blue White/Blue Not used (required) 
6 Receive – Orange/White or Orange Green/White or Green X 
7 N/A White/Brown White/Brown Not used (required) 
8 N/A Brown/White or Brown Brown/White or Brown Not used (required) 

Table 3-1: Standard RJ-45 Wiring Colour Codes 
 
Note the following cabling information for this wiring guide: 
 
• Only two pairs of wires are used in the 8-pin RJ-45 connector to carry Ethernet signals. 
• Even though pins 4, 5, 7 and 8 are not used, it is mandatory that they be present in the cable. 
• 10BaseT and 100BaseT use the same pins (a crossover cable made for one will also work with the 

other). 
• Pairs may be solid colors and not have a stripe. 
• Category 5 cable must use Category 5 rated connectors. 
 
The maximum cable run between the router and the supporting hub is 300 ft (90 m).  The maximum 
combined cable run between any two end points (i.e. router and PC/laptop via network hub) is 675 feet 
(205 m). 
 
Devices on the Ethernet network continually monitor the receive data path for activity as a means of 
checking that the link is working correctly.  When the network is idle, the devices also send a link test 
signal to one another to verify link integrity.  The rear panel is fitted with two LEDs to monitor the Ethernet 
connection.  
 
1000: This Amber LED is ON when a 100Base-TX link is last detected.  The LED is OFF when a 

10Base-T link is last detected (the LINK LED is ON). Upon power-up the LED is OFF as the 
last detected rate is not known and therefore defaults to the 10Base-T state until rate 
detection is completed.  
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LN/ACT: This dual purpose Green LED indicates that the card has established a valid linkage to its 
hub, and whether the module is sending or receiving data.  This LED will be ON when the 
module has established a good link to its supporting hub.  This gives you a good indication 
that the segment is wired correctly. The LED will BLINK when the module is sending or 
receiving data. The LED will be OFF if there is no valid connection.  

 

3.2. HARDWARE INSTALLATION 
To successfully install the 3080IPG-NAT, you will require the following: 
 

1. Unused IP address on the network or a DHCP server. 
2. Evertz serial cable. 
3. VistaLINK® PRO Server IP address. 
4. 3700FC or EMX-FC (depending on the Evertz frame used) for facilitating network communications 

between the frame modules and the configuration software. 
 
Before handling the card it is important to minimize the potential effects of static electricity. It is therefore 
recommended that an ESD strap be worn.   
 
Locate on the chassis 2 adjacent vacant slots. Unpack the 3080IPG-NAT and separate the rear panel 
from the main card. Locate on the rear of the rack the two slots and remove the blanking panels. Insert the 
rear panel into the back of the chassis and secure using the four screws provided.  
 

3.2.1. Installing in 3700FR Frame 
For proper functionality, the Frame Controller should be inserted into the Left slot titled Frame Controller 
1 slot, and the Ethernet connection to the network be inserted into the RJ-45 connector titled Ethernet 1 
on the rear of the frame. 
 
If a Redundant Frame Controller is to be used, insert the redundant FC into the Right slot titled Frame 
Controller 2, and the Ethernet connection into the RJ-45 connector titled Ethernet 2 on the rear of the 
frame. 
 

 
Figure 3-2: 3700FR Frame Ethernet Port 
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3.2.2. Installing in EMX3 
For proper functionality, the Frame Controller should be inserted into the Left most slot, and the Ethernet 
connection to the network be inserted into the RJ-45 connector titled Ethernet 1B on the rear of the frame 
(see Figure 3-3 Red Square on the right). 
 
If a Redundant Frame Controller is to be used, insert the redundant FC into the Right most slot, and the 
Ethernet connection into the RJ-45 connector titled Ethernet 2B on the rear of the frame (see Figure 3-3 
Blue Square on the left). 
 

 
Figure 3-3: EMX-3 Frame Ethernet Port 

 

3.2.3. Installing in EMX6 
For proper functionality, the Frame Controller should be inserted into the Left most slot, and the Ethernet 
connection to the network be inserted into the RJ-45 connector titled Ethernet 1B on the rear of the frame 
(see Figure 3-4 Red Square on the right). 
 
If a Redundant Frame Controller is to be used, insert the redundant FC into the Right most slot, and the 
Ethernet connection into the RJ-45 connector titled Ethernet 2B on the rear of the frame (see Figure 3-4 
Blue Square on the left). 
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Figure 3-4: EMX-6 Frame Ethernet Port 

 
Before inserting the front card, connect the serial cable to the board using the serial cable provided (See 
figure 2-2 for reference). Now insert the 3080IPG-NAT card into the corresponding front slots ensuring the 
card lines up with the slot runners on the bottom and the top of the chassis. Push the card firmly into the 
slot ensuring that when it mates with the rear card it has been firmly pushed into a seated position. Do not 
connect any cables to the rear card (failure to do this could cause unwanted network issues) until the initial 
configuration has been completed. 
 
Connect the 9-pin d-type end of the serial cable to the serial port of your computer. Open a Terminal 
session and configure the port for the following configuration:  
 

Bits per second 115200 
Data Bits 8 
Parity None 
Stop Bits 2 
Flow Control None 

Table 3-2: Port Configuration for Terminal Session 
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Figure 2-5: Serial Connection for 3080IPG-NAT 

 
Click OK to apply these settings and press the return key. The session should respond with the 3080IPG-
NAT Main Menu (see Figure 2-3):  
 

 
Figure 2-6: 3080IPG-NAT Serial Menu 
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1) Network Configuration 
This sub-menu enables the user to configure the control network settings for the card. Configuring 
this sub-menu allows the user to access the card through the VistaLINK® PRO Client interface. 

  
2) SNMP Configuration 

This sub-menu enables the user to configure the Simple Network Management Protocol settings. 
In this menu you can set or remove the SNMP trap IP address and the SNMP Read and Set 
community strings. 

 
3) Data Network Configuration  

This sub-menu is used to configure the data port settings. This configuration is also performed via 
VistaLINK® PRO will not be covered in this section. 

 
4) NAT System Configuration 

This sub-menu is used to configure the 3080IPG_NAT functions through the serial menu 
 

5) Trace – Engineering Only 
This menu is for Evertz technical support staff only. You may be requested to access and execute 
the available options to enable the viewing of certain system events during troubleshooting. 

 
6) Engineering/Debug 

This menu is for Evertz technical support staff only. You may be requested to access and execute 
options within this menu when seeking technical support from Evertz. Guidance will be given 
should this be required. 

 
Before is it possible to configure the card via VistaLINK® PRO it is first necessary to configure the initial 
basic network settings via the serial cable.  Refer to section 2.3. 
 

3.3. CONFIGURING THE BASIC NETWORK SETTINGS 
Now select option (1) Network Configuration, the Network Configuration menu will be displayed as shown 
in Figure 2-4. If you prefer to use DHCP then you may select option (5) Use DHCP, and then continue 
from step 4: 
 

1. Select option (1) Set IP Address and configure the IP address for the 3080IPG-NAT ensuring that 
the IP address is not already in use on the network.  
 

2. Now select option (2) Set Netmask and configure the correct subnet mask for your network. 
  

3. If required also configure option (3) Set Gateway and (4) Set Broadcast Address. 
 

4. Exit from the Network Configuration menu using (S) Save and Exit, NOT (X) Exit. 
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Figure 2-7: Network Configuration Sub-Menu 

 
From the Main Menu, select option (2) SNMP Configuration. Select option (1) Set IP Address and enter 
the IP address of your VistaLINK® PRO Server.  Exit using option (S) Save and Exit, now extract the card 
from the rack, remove the serial cable and re-insert it. 
 
You have now completed the minimum necessary network configuration and can connect the cables to the 
rear card when ready. 
 

3.4. CONNECTING TO VLPRO 

It’s assumed that the VistaLINK® PRO server and client are already configured for your network and you 
have basic knowledge of the VistaLINK® PRO interface. It is also assumed that the user or network 
administrator has already added the appropriate jar file to the server, and both the client and server 
applications have been restarted.  Please refer to the VistaLINK® PRO manual for instruction on how to 
load a jar file.  If you are the network administrator refer to section 5.1 for information on updating the 
VistaLINK® PRO Server Jar File. 
 
Open VistaLINK® PRO and click on the refresh tree icon. Expand the hardware tree by clicking on the “+” 
button. Your card should appear as a newly listed device with its IP address used to configure the card in 
Step 3.3 above. It may take up to a minute to appear while the card and switch negotiate network settings 
(this can be verified directly on the switch if necessary).  
 

 

Note: If after a couple of minutes the card has still not appeared, try selecting Add 
Agent from the Tree> Add/Update Agent menu. Enter the IP address and select 
OK.  The card should now be listed and will remain grayed out for a moment while 
VistaLINK® PRO finds the card and confirms its configuration. 

 
Please consult your network administrator if you continue to have problems connecting the card with 
VistaLINK® PRO, alternatively contact Evertz Microsystems Ltd. or your authorized reseller for technical 
support.
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4. CARD CONFIGURATION 

Right click the IP address of the 3080IPG-NAT to access and configure their parameters. Select “View 
Configuration”. The configuration page will open, enabling the user to toggle the configuration tabs in order 
to configure the parameters of the 3080IPG-NAT. Sections 4.1 to 4.3 provide an explanation of the 
features and functions of the 3080IPG-NAT card. 
 

4.1. GENERAL TAB 

Right click the IP address and select “View Configuration” which will prompt you to the “General” tab (see 
Figure 4-1). 
 

 
Figure 4-1: General Tab 

 
Card Control: 
 

• Reboot Card: Reboot the card from VLPRO itself but the connection is going to be lost for around 
1-2 minutes. 
 

• Card NAT Mode: Control for configuring the different modes of operation of the 3080NAT. Modes 
of Operation are: IP NAT, VLAN-Based NAT, and Port-Based NAT.  
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• Flow Count: Displays the number of flows configured on the card. 
Port 1 - 4:  
 

• IP Address: Set the IP Address for corresponding Ethernet port, a reboot is required after 
modifying this field. 
 

• Netmask Address: Set the Netmask Address for corresponding Ethernet port, a reboot is required 
after modifying this field. 

 
• Gateway Address: Set the Gateway Address for corresponding Ethernet port, a reboot is required 

after modifying this field. 
 

• Broadcast Address: Set the Broadcast Address for corresponding Ethernet port, a reboot is 
required after modifying this field. 

 

4.2. ETHERNET PORT MONITOR TAB 

Right click the IP address and select “View Configuration”  “Ethernet Port 1&2 Monitor” or “Ethernet Port 
3&4 Monitor”   to access configuration dialogue box (see Figure 4-2). 
 
The tab displays the Status of each Data port. The status will not change unless a valid flow is detected 
(you may be required to refresh the status or select auto-refresh to view the change). 
 

 
Note: For the sake of simplicity only Ethernet Port 1 field will be described in this 
manual. 
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Figure 4-2: Ethernet Ports Monitor Tab 

 
Port 1 Monitor: 
  

• Link Status (Port 1): This parameter returns the lin kStatus for IP Ports. 
 

• Link Speed: Displays the link speed in Mbps for given ethernet port. 
  
Received: 
 

• Receive Bandwidth: This parameter returns the receive bandwith for ethernet port. 
 

 
Note: Unit is kbps. 

 
• Error-Free Frames Received: This parameter returns number of good ethernet packets received. 

 
• Erroneous Frames Received: This parameter returns number of Ethernet packets received with 

errors. 
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• Broadcast Frames Received: This parameter returns number of broadcast packets received. 
 

• Unicast Frames Received: This parameter returns number of unicast packets received. 
 

• Multicast Frames Received: This parameter returns number of multicast packets received. 
 
Transmitted: 
 

• Transmit Bandwidth: This parameter returns the transmit bandwith for ethernet port. 
 

 
Note: Unit is kbps. 

 
• Error-Free Frames Transmitted: This parameter returns number of good ethernet packets 

transmitted. 
 

• Erroneous Frames Transmitted: This parameter returns number of Ethernet packets transmitted 
with errors. 

 
• Broadcast Frames Transmit: This parameter returns number of broadcast packets transmitted. 

 
• Unicast Frames Transmit: This parameter returns number of unicast packets transmitted. 

 
• Multicast Frames Transmit: This parameter returns number of multicast packets transmitted. 

 
• Clear Stats (Port 1): This parameter allows the user to clear all the statistics for the ethernet port. 

 

4.3. FLOW CONTROL TAB 

Right click the IP address and select “View Configuration”  “Flow Control” to access configuration 
dialogue box. The design of the flow control tab depends on the NAT mode that has been selected in the 
general tab. We are going to be covering all the three mode of operations. 
 

4.3.1. IP NAT 
Select the IP NAT mode by going to the “General” tab and choosing IP NAT from the Card NAT Mode 
menu. The “Flow Control” tab for IP NAT can be seen in Figure 4-3.  
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 Figure 4-3: IP NAT - Flow Control Tab 

 
Flow: Index for various flows, around 2048 different flows can be configured on one NAT.  
 

 
Note: Flows 1-1024 correspond to ports 1 & 2 only whereas flows 1025-2048 
correspond to ports 3 & 4 only.  

 
Input IGMPv3 SSM Source Address: 
 

• IGMPv3 Mode: This parameter Allows user to select IGMPv3 mode, include or exclude.  
 

• IGMPv3 Source Select: Flow Input IGMP SSM Source Count. Displays the number of addresses 
in the IGMP SSM Source list. 

 
• IGMPv3 Source 1: This parameter allows user to set IGMPv3 SSM source IP address. 

 
Input Control: 
 

• Enable: Enables packet receiving on given flow. 
 

• Destination IP Address: Allows user to select Destination ip Address of the packet to be received. 
 

• Destination UDP Port: Allows user to select the Dest. UDP Port number to be received. 
 

• Ethernet Port: Displays the ethernet port associated with given flow input channel. 
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Output Control: 
 

• Flow Output Mode: Allows user to select mode for the flow. 
 

o Disable: No output. 
 

o Passthrough: Nothing changes in the header of IP packet. 
 

o Modify: Modifies the packet based on the other parameters. 
 

• Source MAC Address: Displays the source MAC address in the output packets of the flow. String 
format aa:bb:cc:dd:ee:ff. 
 

• Source IP Address: Displays the source IP Address in the output packets of the flow. 
 

• Source UDP Port: Displays the source UDP Port number in the output packets for the flow. 
 

• Destination MAC Address: Displays the destination MAC address in the output packets of the 
flow. String format aa:bb:cc:dd:ee:ff. 
 

• Destination IP Address: Displays the destination IP Address in the output packets for the flow. 
 

• Destination UDP Port: Displays the destination UDP Port number in the output packets for the 
flow. 

 
• Ethernet Port: Displays the ethernet port associated with given flow input channel. 

 
4.3.2. VLAN based NAT 
 
Select the VLAN based NAT mode by going to the “General” tab and choosing VLAN based NAT from the 
Card NAT Mode menu. The “Flow Control” tab for VLAN based NAT can be seen in Figure 4-4. 
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Figure 4-4: VLAN based NAT - Flow Control Tab 

 
Flow: Index for various flows, around 2048 different flows can be configured on one NAT.  
 

 
Note: Flows 1-1024 correspond to ports 1 & 2 only whereas flows 1025-2048 
correspond to ports 3 & 4 only. 

 
Input IGMPv3 SSM Source Address: 
 

• IGMPv3 Mode: This parameter Allows user to select IGMPv3 mode, include or exclude.  
 

• IGMPv3 Source Select: Flow Input IGMP SSM Source Count. Displays the number of addresses 
in the IGMP SSM Source list. 

 
• IGMPv3 Source 1: This parameter allows user to set IGMPv3 SSM source IP address. 

 
VLAN-Based Encapsulate Control: 
 

• Input VLAN ID: Control used in VLAN-Based NAT mode for assigning VLAN ID to given Flow. 
Incoming packets of the flow, with specified VLAN ID, will then be encapsulated. 
 

• Output Source IP Address: Control used in VLAN-Based NAT mode for specifying the source IP 
address. Outgoing packets of the flow will be encapsulated with given source IP address. 
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• Output Destination IP Address: Control used in VLAN-Based NAT mode for specifying the 
destination IP address. Outgoing packets of the flow will be encapsulated with given destination IP 
address. 
 

• Output Source UDP Port: Control used in VLAN-Based NAT mode for specifying the source UDP 
port . Outgoing packets of the flow will be encapsulated with given source UDP port. 
 

• Ouput Destination UDP Port: Control used in VLAN-Based NAT mode for specifying the 
destination UDP port. Outgoing packets of the flow will be encapsulated with given destination 
UDP port. 
 

• Encapsulate Flow Input Enable: Control used in VLAN-Based NAT mode for enabling and 
disabling encapsulation packet receiving on given flow. 
 

• Input Ethernet Port: Displays the input ethernet port associated with given flow input channel. 
 

• Output Ethernet Port: Displays the output ethernet port associated with given flow input channel. 
 
VLAN-Based Decapsulate Control: 
 

• Input Destination IP Address:  Control used in VLAN-Based NAT mode for specifying the 
destination IP address. Incoming packets of the flow, with matching destination IP address, will be 
encapsulated. 
 

• Input Destination UDP Port: Control used in VLAN-Based NAT mode for specifying the 
destination UDP port. incoming packets of the flow will be decapsulated with given destination 
UDP port. 
 

• Decapsulate Flow Input Enable: Control used in VLAN-Based NAT mode for enabling and 
disabling decapsulation packet receiving on given flow. 

 
• Input Ethernet Port: Displays the input ethernet port associated with given flow input channel. 

 
• Output Ethernet Port: Displays the output ethernet port associated with given flow input channel. 

 
4.3.3.  PORT based NAT  
Select the PORT based NAT mode by going to the “General” tab and choosing PORT based NAT from the 
Card NAT Mode menu. The “Flow Control” tab for PORT based NAT can be seen in Figure 4-5. 
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Figure 4-5: PORT based NAT - Flow Control Tab 

 
Flow: Index for various flows, up to 2048 different flows can be configured on one NAT.  
 

 
NOTE: Flows 1-1024 correspond to ports 1 & 2 only whereas flows 1025-2048 
correspond to ports 3 & 4 only.  

 
Input IGMPv3 SSM Source Address: 
 

• IGMPv3 Mode: This parameter Allows user to select IGMPv3 mode, include or exclude.  
 

• IGMPv3 Source Select: Flow Input IGMP SSM Source Count. Displays the number of addresses 
in the IGMP SSM Source list. 

 
• IGMPv3 Source 1: This parameter allows user to set IGMPv3 SSM source IP address. 

 
Port-Based Encapsulate Control: 
 

• Output Source IP Address: Control used in Port-Based NAT mode for specifying the source IP 
address. Outgoing packets of the flow will be encapsulated with given source IP address. 

 
• Output Destination IP Address: Control used in Port-Based NAT mode for specifying the 

destination IP address. Outgoing packets of the flow will be encapsulated with given destination IP 
address. 
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• Output Source UDP Port: Control used in Port-Based NAT mode for specifying the source UDP 
port . Outgoing packets of the flow will be encapsulated with given source UDP port. 
 

• Ouput Destination UDP Port: Control used in Port-Based NAT mode for specifying the 
destination UDP port. Outgoing packets of the flow will be encapsulated with given destination 
UDP port. 
 

• Encapsulate Flow Input Enable: Control used in Port-Based NAT mode for enabling and 
disabling encapsulation packet receiving on given flow. 
 

• Input Ethernet Port: Displays the input ethernet port associated with given flow input channel. 
 

• Output Ethernet Port: Displays the output ethernet port associated with given flow input channel. 
 
Port-Based Decapsulate Control: 
 

• Input Destination IP Address:  Control used in Port-Based NAT mode for specifying the 
destination IP address. Incoming packets of the flow, with matching destination IP address, will be 
encapsulated. 
 

• Input Destination UDP Port: Control used in Port-Based NAT mode for specifying the destination 
UDP port. Incoming packets of the flow will be decapsulated with given destination UDP port. 
 

• Decapsulate Flow Input Enable: Control used in Port-Based NAT mode for enabling and 
disabling decapsulation packet receiving on given flow. 

 
• Input Ethernet Port: Displays the input ethernet port associated with given flow input channel. 

 
• Output Ethernet Port: Displays the output ethernet port associated with given flow input channel. 

 

4.3.4. CLEAR TAB 
Right click the IP address and select “View Configuration”  “Clear” to access configuration dialogue box 
(see Figure 4-6). Control clears out the configuration of the given flow and restores it to the factory default 
setting. 
 

 
Figure 4-6: Clear Tab
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5. TROUBLESHOOTING 

5.1. UPDATING VLPRO SERVER JAR FILE  

Evertz products are constantly evolving and new features are often added. It is therefore important to 
update the JAR files in use to provide access to all the latest features or enhancements. It will also be 
necessary to add JAR files for new products. If your new product has not appeared even after waiting a 
few minutes for the Ethernet switch negotiation to complete, then it is possible that your JAR file may be 
old or missing. 
 
To perform a JAR update, ensure that all VistaLINK® PRO clients are closed (those clients which are not 
closed will automatically be disconnected as soon as the VistaLINK® PRO Server is restarted). Maximize 
the VistaLINK® PRO Server window from the Windows task bar, select Help> Apply Update> Product from 
the menu.  
 

 
Figure 5-1: VistaLINK® PRO Server  

 
A window will appear, as shown in Figure 5-2, navigate to the location of the new JAR file and double click 
to select the file. The window will automatically close and the update will be applied in the background.  

 



EMX3/EMX6/3000FR/3700 MultiFrame Manual 
3080IPG-NAT-2-10GE High Density Network Address Translator 

Page - 24 Revision 1.0 TROUBLESHOOTING 

 
Figure 5-2: VistaLINK® PRO – Applying JAR Updates 

 
You will be prompted to restart the server to enable the change to take effect. Apply as many JAR updates 
as required before restarting the server. 
 

 
 
 

 
NOTE: You may confirm that all updates have been successfully applied by selecting 
from the menu Tools>View>Show/Hide Product update log. 

 
From the menu, shutdown the server by selecting File>Shutdown Server. Now re-open the server, it is 
normal for the start-up to take marginally longer while each individual update is being applied. Once 
complete, you may restart the VistaLINK® PRO Clients. As the Client restarts you will experience a short 
delay while the update is applied. A prompt will appear confirming that the updates have been applied. 
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